Inserting Pictures and Adding Effects

The Bird Migration presentation consists of four slides that have some text, a clip art image, a formatted background, and a transition applied to all slides. You will insert pictures into two slides and then modify them by adding artistic effects and recoloring. You also will copy the clip art from Slide 2 to Slide 1 and modify the objects in this clip. In Chapter 2, you inserted pictures, made corrections, and added styles and effects; the new effects you apply in this chapter will add to your repertoire of picture enhancements that increase interest in your presentation.

In the following pages, you will perform these tasks:
1. Insert the first digital picture into Slide 1.
2. Insert the second digital picture into Slide 3.
3. Recolor the Slide 3 picture.
4. Recolor and add an artistic effect to the Slide 1 picture.
5. Add an artistic effect to the Slide 3 picture.
6. Send the Slide 3 picture back behind all other slide objects.
7. Send the Slide 1 picture back behind all other slide objects.

To Insert and Resize Pictures into Slides without Content Placeholders

The next step is to insert digital pictures into Slides 1 and 3. These pictures are available on the Data Files for Students. See the inside back cover of this book for instructions on downloading the Data Files for Students, or contact your instructor for information about accessing the required files.

The following steps insert pictures into Slides 1 and 3.

1. With Slide 1 displaying and your USB flash drive connected to one of the computer’s USB ports, click Insert on the Ribbon to display the Insert tab and then click the Picture button (Insert tab | Images group) to display the Insert Picture dialog box.

2. If necessary, navigate to the picture location (in this case, the PowerPoint folder in the CIS 101 folder [or your class folder] on the USB flash drive). For a detailed example of this procedure, refer to Steps 3a–3c on pages OFF 28 and OFF 29 in the Office 2010 and Windows 7 chapter at the beginning of this book.

3. Click Birds in Sky to select the file.

4. Click the Insert button (Insert Picture dialog box) to insert the picture into Slide 1.

5. Resize the picture so that it covers the entire slide (approximately 7.5” × 10”).

6. Display Slide 3, display the Insert tab, click the Picture button to display the Insert Picture dialog box, and then insert the Bird Reflect picture into Slide 3.

7. Resize the picture so that it covers the entire slide (approximately 7.5” × 10”) (Figure 3–2).

Q&A

How do I resize the picture so that it maintains its proportions?

Press and hold the SHIFT key while dragging a sizing handle away from or toward the center of the picture. To maintain the picture’s proportions and keep its center in the same location, press and hold down both the CTRL and SHIFT keys while you drag a sizing handle.
Use the color wheel to determine color choices.

The color wheel is one of designers’ basic tools. Twelve colors on the wheel are arranged in a specific order, with the three primary colors — red, yellow, and blue — forming a triangle. Between the primary colors are the secondary colors that are formed when the primary colors are mixed. For example, red and yellow mixed together form orange; red and blue form purple; and yellow and blue form green. The six other colors on the wheel are formed when the primary colors are mixed with the secondary colors.

Red, orange, and yellow are considered warm colors, and they display adjacent to each other on one side of the wheel. They are bold and lively, so you should use them when your message is intended to invigorate an audience and create a pleasing effect. Opposite the warm colors are the cool colors: green, blue, and purple. They generate a relaxing, calming atmosphere.

If you put a primary and secondary color together, such as red and purple, your slide will make a very bold and vivid statement. Be certain that effect is one you intend when planning your message.

Adjusting Picture Colors

PowerPoint allows you to adjust colors to match or add contrast to slide elements by coloring pictures. The Color Picture gallery has a wide variety of preset formatting combinations. The thumbnails in the gallery display the more common color saturation, color tone, and recolor adjustments. Color saturation changes the intensity of colors. High saturation produces vivid colors; low saturation produces gray tones. Color tone affects the coolness, called blue, or the warmth, called orange, of pictures. When a digital camera does not measure the tone correctly, a color cast occurs, and, as a result, one color dominates the picture. Recolor effects convert the picture into a wide variety of hues. The more common are grayscale, which changes the color picture into black, white, and shades of gray, and sepia, which changes the picture colors into brown, gold, and yellow, reminiscent of a faded photo. You also can fine-tune the color adjustments by clicking Picture Color Options and More Variations commands in the Color gallery.
To Color a Picture

The Slipstream theme and text on Slides 1 and 3 have many shades of blue. The inserted pictures, in addition, have blue backgrounds. The following steps recolor the Slide 3 picture to coordinate with the blue colors on the slide.

1. With Slide 3 displaying and the Bird Reflect picture selected, click the Color button (Picture Tools Format tab | Adjust group) to display the Color gallery (Figure 3–3).

   Q&A
   Why does the Adjust group look different on my screen?
   Your monitor is set to a different resolution. See Chapter 1 for an explanation of screen resolution and the appearance of the Ribbon.

   Why are yellow borders surrounding the thumbnails in the Color Saturation and Color Tone areas in the gallery?
   The image on Slide 3 currently has normal color saturation and a normal color tone.

2. Point to Blue, Accent color 1 Light (second picture in last row of Recolor area) to display a live preview of this adjustment on the picture.

   Experiment
   - Point to various thumbnails in the Recolor area and watch the hues change on the picture in Slide 3.
   - Click Blue, Accent color 1 Light to apply this correction to the Bird Reflect picture (Figure 3–4).

   Q&A
   Could I have applied this correction to the picture if it had been a background instead of a file inserted into the slide?
   No. Artistic effects cannot be applied to backgrounds.
To Color a Second Picture

The Slide 1 picture has rich hues and is very prominent on the slide. To soften its appearance and to provide continuity with the Slide 3 picture, you can color this picture. The following steps color the picture on the title slide.

1. Display Slide 1 and then click the picture to select it. Click the Color button (Picture Tools Format tab | Adjust group) to display the Color gallery.

2. Click Washout (fourth picture in first row of Recolor area) to apply this correction to the Bird Reflect picture (Figure 3–5).

---

Figure 3–5

To Add an Artistic Effect to a Picture

Artists use a variety of techniques to create effects in their paintings. For example, they can vary the amount of paint on their brushstroke, use fine bristles to add details, mix colors to increase or decrease intensity, and smooth their paints together to blend the colors. You, likewise, can add similar effects to your pictures using PowerPoint's built-in artistic effects. The following steps add an artistic effect to the Slide 3 picture.
1. With the Birds in Sky picture selected in Slide 1, click the Artistic Effects button (Picture Tools Format tab | Adjust group) to display the Artistic Effects gallery (Figure 3–6).

Why does the Adjust group look different on my screen?
Your monitor is set to a different resolution. See Chapter 1 for an explanation of screen resolution and the appearance of the Ribbon.

Q&A

Why is a yellow border surrounding the first thumbnail in the gallery?
The first thumbnail shows a preview of the image on Slide 1 with no artistic effect applied.

Figure 3–6

2. Point to Film Grain (third picture in third row) to display a live preview of this adjustment on the picture.

Experiment

• Point to various thumbnails and watch the hues change on the picture in Slide 1.
• Click Film Grain to apply this correction to the Birds in Sky picture (Figure 3–7).

Q&A

Must I adjust a picture by recoloring and applying an artistic effect?
No. You can apply either a color or an effect. You may prefer at times to mix these adjustments to create a unique image.

Figure 3–7
To Add an Artistic Effect to a Second Picture

The Slide 3 picture was softened when you applied a blue accent color. You can further change the images and provide continuity with the Slide 1 picture by applying an artistic effect. The following steps add an artistic effect to the Slide 3 picture.

1 Display Slide 3 and then click the picture to select it. If necessary, click the Picture Tools Format tab and then click the Artistic Effects button (Picture Tools Format tab | Adjust group) to display the Artistic Effects gallery.

2 Click Glow Diffused (fourth picture in second row) to apply this effect to the Bird Reflect picture (Figure 3–8).

Figure 3–8

To Change the Stacking Order

The objects on a slide stack on top of each other, much like individual cards in a deck. On Slides 1 and 3, the pictures you inserted are on top of text placeholders. To change the order of these objects, you use the Bring Forward and Send Backward commands. Bring Forward moves an object toward the top of the stack, and Send Backward moves an object underneath another object. When you click the Bring Forward button arrow, PowerPoint displays a menu with an additional command, Bring to Front, which moves a selected object to the top of the stack. Likewise, when you click the Send Backward button arrow, the Send to Back button moves the selected object underneath all objects on the slide. The following steps arrange the Slide 3 and Slide 1 pictures by sending them to the bottom of the stack on each slide.
1. With the Bird Reflect picture selected in Slide 3, click the Send Backward button arrow (Picture Tools Format tab | Arrange group) to display the Send Backward menu (Figure 3–9).

Q&A

How can I see objects that are not on the top of the stack?
Press TAB or SHIFT+TAB to display each slide object.

2. Click Send to Back to move the picture underneath all slide objects (Figure 3–10).

3. Display Slide 1, select the Birds in Sky picture, and then click the Send Backward button arrow (Picture Tools Format tab | Arrange group).

   - Click Send to Back to move the picture underneath all slide objects (Figure 3–11).

---

Other Ways

1. Click Send to Back (Picture Tools Format tab | Arrange group), press K
2. Point to Send to Back on shortcut menu, click Send to Back

Copyright 2010 Cengage Learning, Inc. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.
Modifying Placeholders and Deleting a Slide

You have become familiar with inserting text and graphical content in the three types of placeholders: title, subtitle, and content. These placeholders can be moved, resized, and deleted to meet desired design requirements. In addition, placeholders can be added to a slide when needed. After you have modified the placeholder locations, you can view thumbnails of all your slides simultaneously by changing views.

In the following pages, you will perform these tasks:

1. Resize and move the Slide 1 title text placeholder.
2. Delete the Slide 1 subtitle text placeholder.
3. Align the Slide 1 and Slide 3 paragraph text.
5. Change views.

To Resize a Placeholder

The AutoFit button displays on the left side of the Slide 1 title text placeholder because the two lines of text exceed the placeholder's borders. PowerPoint attempts to reduce the font size when the text does not fit, and you can click this button to resize the existing text in the placeholder so the spillover text will fit within the borders. You also can resize the placeholder so that the letters fit within the rectangle. The following step increases the Slide 1 title text placeholder.

With Slide 1 displaying, click somewhere in the title text paragraph to position the insertion point in the paragraph. Click the border of the title text placeholder to select it. Point to the bottom-middle sizing handle so that the mouse pointer changes to a two-headed arrow.

Drag the bottom border downward to enlarge the text placeholder (Figure 3–12).

Can I drag other sizing handles to enlarge or shrink the placeholder?
Yes, you also can drag the left, right, top, and corner sizing handles to resize a placeholder.

How do the square sizing handles differ from circle sizing handles?
Dragging a square handle alters the shape of the text box so that it is wider or taller. Dragging a circle handle keeps the box in the same proportion and simply enlarges the overall shape.

To Move a Placeholder

The theme layouts determine where the text and content placeholders display on the slide. If you desire to have a placeholder appear in a different area of the slide, you can move it to a new location. The Slide 1 title placeholder currently displays in the upper third of the slide, but the text in this placeholder would be more aesthetically pleasing if it were moved toward the center of the slide. The following step moves the Slide 1 title text placeholder.
1. With the Slide 1 title text placeholder border displaying as a solid line, point to an area of the bottom border between two sizing handles so that the mouse pointer changes to a four-headed arrow.

What if the placeholder border displays as a dotted line?
Click the border to change the line from dotted to solid.

Can I click any part of the border, or do I need to click the bottom edge?
You can click any of the four border lines.

Drag the placeholder downward so that it overlaps part of the subtitle text placeholder (Figure 3–13).

Click to set the placeholder in its new location.

---

**To Delete a Placeholder**

When you run a slide show, empty placeholders do not display. You may desire to delete unused placeholders from a slide so that they are not a distraction when you are designing slide content. The subtitle text placeholder on Slide 1 is not required for this presentation, so you can remove it. The following steps remove the Slide 1 subtitle text placeholder.

1. Click a border of the subtitle text placeholder so that it displays as a solid line or fine dots (Figure 3–14).

What if the placeholder border is displaying as a dotted line?
Click the border to change the line from dotted to solid or fine dots.

2. Press the DELETE key to remove the placeholder.

Can I click the Cut button (Home tab | Clipboard group) to delete the placeholder?
Yes. Clicking the Cut button deletes the placeholder if it does not contain any text.

---

**BTW**

**Reusing Placeholders**

If you need to show the same formatted placeholder on multiple slides, you may want to customize a slide master and insert a placeholder into a slide layout. Using a slide master saves you time because you do not need to type the same information in more than one slide. The slide master is useful when you have extremely long presentations. Every document theme has several slide masters that indicate the size and position of text and object placeholders. Any change you make to a slide master results in changing that component in every slide of the presentation.
Plan Ahead

**Vary paragraph alignment.**
Designers use alignment within paragraphs to aid readability and to indicate relationships among slide elements. English language readers are accustomed to seeing paragraphs that are aligned left. When paragraphs are aligned right, the viewer’s eyes are drawn to this unexpected text design. If your paragraph is short, consider centering or right-aligning the text for emphasis.

---

**To Align Paragraph Text**

The presentation theme determines the formatting characteristics of fonts and colors. It also establishes paragraph formatting, including the alignment of text. Some themes center the text paragraphs between the left and right placeholder borders, while others **left-align** the paragraph so that the first character of a text line is near the left border or **right-align** the paragraph so that the last character of a text line is near the right border. The paragraph also can be **justified** so that the text is aligned to both the left and right borders. When PowerPoint justifies text, it adds extra spaces between the words to fill the entire line.

The words, Birds of a Feather, are centered in the Slide 1 title text placeholder. Later, you will add clip art above the word, Feather, so you desire to left-align the paragraph to make room for this art. In addition, the words in the Slide 3 title text placeholder, Bird Migration, are covering the bird in the picture. You can right-align these words to uncover the bird in the lower-left corner. The following steps change the alignment of the Slide 1 and Slide 3 title placeholders.

1. With the Home tab displayed, click somewhere in the title text paragraph of Slide 1 to position the insertion point in the paragraph to be formatted (Figure 3–15).

---

**Figure 3–15**